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NOTICE

Published by: Multi-Computing
1051 Stuyvesant Avenue
Suite 347
Union, New Jersey 07083
Telephone: 908-241-8071

Copyright: This manual and software are copyrighted
by Multi-Computing.

(C) COPYRIGHT 1996 BY MULTI-COMPUTING.
ALL RIGHTS ARE RESERVED WORLDWIDE.

Selected images in this program are
copyrighted by Softkey International,
Inc.

Definition of Shareware  Shareware distribution gives users a
chance to try software before buying it.
If you try a Shareware program and
continue using it, you are expected to
register. Individual programs differ on
details -- some request registration
while others require it, some specify a
maximum trial period. With registration,
you get anything from the simple right
to continue using the software to an
updated program with printed manual.

Copyright laws apply to both Shareware
and commercial software, and the
copyright holder retains all rights,
with a few specific exceptions as stated
below. Shareware authors are
accomplished programmers, just like
commercial authors, and the programs are
of comparable quality. (In both cases,
there are good programs and bad ones!)
The main difference is in the method of
distribution. The author specifically
grants the right to copy and distribute
the software, either to all and sundry
or to a specific group. For example,
some authors require written permission
before a commercial disk vendor may copy
their Shareware.

Shareware is a distribution method, not
a type of software. You should find
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software that suits your needs and
pocketbook, whether it's commercial or
Shareware. The Shareware system makes
fitting your needs easier, because you
can try before you buy. And because the
overhead is low, prices are low also.
Shareware has the ultimate money-back
guarantee -- if you don't use the
product, you don't pay for it.

Disclaimer - Agreement   Users of BabyKeys must accept this
disclaimer of warranty: "BabyKeys is
supplied as is.  The author disclaims
all warranties, expressed or implied,
including, without limitation, the
warranties of merchantability and of
fitness for any purpose. The author
assumes no liability for damages, direct
or consequential, which may result from
the use of BabyKeys."

BabyKeys is a "shareware program" and is
provided at no charge to the user for
evaluation.  Feel free to share it with
your friends, but please do not give it
away altered or as part of another
system.  The essence of "user-supported"
software is to provide personal computer
users with quality software without high
prices, and yet to provide incentive for
programmers to continue to develop new
products.  If you find this program
useful and find that you are using
BabyKeys and continue to use BabyKeys
after a reasonable trial period, you
must make a registration payment of
$19.951 to Multi-Computing.  The $19.95
registration fee will license one copy
for use on any one computer at any one
time.  You must treat this software just
like a book.  An example is that this
software may be used by any number of
people and may be freely moved from one
computer location to another, so long as
there is no possibility of it being used

                             

1 Shipping/Handling is free in the United States. Please
see the order form on page 11 for international
shipping rates.
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at one location while it's being used at
another. Just as a book cannot be read
by two different persons at the same
time.

Anyone distributing BabyKeys for any
kind of remuneration must first contact
Multi-Computing at the address below for
authorization. This authorization will
be automatically granted to distributors
recognized by the (ASP) as adhering to
its guidelines for shareware
distributors, and such distributors may
begin offering BabyKeys immediately
(However Multi-Computing must still be
advised so that the distributor can be
kept up-to-date with the latest version
of BabyKeys.). Distributors and vendors
can contact Multi-Computing using the
following address or telephone number:

Multi-Computing
1051 Stuyvesant Avenue
Suite 347
Union, NJ  07083

Telephone: 908-241-8071

You are encouraged to pass a copy of
BabyKeys along to your friends for
evaluation.  Please encourage them to
register their copy if they find that
they can use it.  All registered users
will receive a copy of the latest
version of the BabyKeys system. Please
see "Benefits of Registration" (page 9)
for more information on registering
BabyKeys.

Trademarks: CompuServe is the registered trademark
of Compuserve Incorporated.

Logitech Mouse is the registered
trademark of Logitech, Inc.
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Mouse Systems Mouse is the registered
trademark of Mouse Systems, Inc.

MS-DOS, Microsoft Mouse, Windows 3.1 and
Windows95 are the registered trademarks
of Microsoft Corporation.

Novell DOS is the registered trademark
of Novell, Inc.

PC-DOS and IBM are the registered
trademarks of International Business
Machines, Inc.

Acknowledgements: Special thanks to these members of my
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creation of BabyKeys for Windows:

Alex Blenman My six month old son
who was the youngest
beta tester of this
program.

Amelia Blenman My daughter who beta
tested the program
and provided many of
the background
voices.

Alice Blenman My wife whose
patience and support
made this product
possible. She was
also used as both a
beta tester and
proofreader.
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INTRODUCTION

BABYKEYS - BACKGROUND AND OVERVIEW
              BabyKeys was designed to satisfy the curiosity of children
              ages six months through three years. Children in this age
              grouping have an attraction for colors and music.
              Additionally, they are also curious about your computer's
              keyboard and monitor.

              BabyKeys satisfies this curiosity by responding to what your
              child does to the computer keyboard or mouse. When your
              child presses the buttons on one of these devices, BabyKeys
              responds with attractive graphics, pictures, music and audio
              descriptions of the pictures displayed.

              Back in 1990, when Amelia (my daughter) was almost six
              months old, I observed her interest in my computer. So I
              decided to design a computer program just for her. She
              became my beta tester as the program was being designed. A
              short time later, BabyKeys was born. BabyKeys has now
              evolved into a Windows based application with multimedia
              features such as speech, music as well as bitmap graphics.

SYSTEM REQUIREMENTS
              BabyKeys requires the following hardware and software:

o A 100% IBM compatible 386DX or higher computer.
o 4MB of memory for Windows 3.1 or 8MB for

Windows95. More memory is recommended for better
performance.

o A hard disk with at least 7MB of available space
free for program and data files. Up to 12MB of
disk space may be needed during the installation
process.

o An optional printer for printing the user manual.
o A 640 by 480 display monitor and a VGA card. We

recommend a high resolution monitor (1024 by 768
or better) with at least an SVGA card.

o An internal PC speaker. We recommend a sound card
with external speakers to get the most out of this
program.

o Microsoft, Mouse Systems, Logitech or compatible
mouse.
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o Windows 3.1 with a Windows 3.1 compatible version
of DOS2 or Windows95.

COMPATIBILITY
              Users who have a sound card capable of playing WAV files
              should have no trouble using this program3. However, users
              relying on the Microsoft SPEAKER.DRV device driver may
              experience inconsistent results when running this program.
              If you experience difficulties when using SPEAKER.DRV, you
              may want to do the following:

                   If you are using Windows 3.1 and would like to remove
                   this device driver,

                        1.   Double click on the Control Panel icon under
                             the "Main" group.
                        2.   Double click on the Drivers icon.
                        3.   Under the "Installed Drivers" list, click on
                             Sound Driver for PC-Speaker (Speaker.drv).
                        4.   Click on the Remove button.
                        5.   A dialog box will appear asking you to
                             restart Windows. To have the removal take
                             effect immediately, choose the Restart Now
                             button.

                   If you are using Windows95,

                        1.   Double click on the My Computer icon.
                        2.   Double on Control Panel.
                        3.   Double click on Multimedia.
                        4.   Click on the Advanced tab.
                        5.   Double click on Audio Devices.
                        6.   Click on Audio for Sound Driver For PC-
                             Speaker then click on [Properties].
                        7.   If you would like to disable the PC-Speaker

                             

2 PC/MS-DOS versions starting from 3.1 or Novell DOS 7.x.

3 To know if your sound card can play WAV files, try using the
Media Player utility found in the Accessories group (See
Troubleshooting on page 14 for more information).
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                             driver, then:

                             (i)       Click on the Do not use audio
                                       features of this device option.
                             (ii)      Click on the [OK] button.
                             (iii)     The message "These changes may not
                                       take effect until you restart
                                       Windows" will be displayed.
                             (iv)      Click on the [OK] button.

                             If you would like to remove the PC-Speaker
                             driver, then:

                             (i)       Click on the [Remove] button.
                             (ii)      The dialog message "If you remove
                                       this driver, you will lose the
                                       Audio features it provides."
                                       followed by the question "Are you
                                       sure you want to remove this
                                       driver?".
                             (iii)     To confirm that you want to remove
                                       this driver, click on the [Yes]
                                       button.
                             (iv)      Click on the [OK] button.
                             (v)       The message "These changes may not
                                       take effect until you restart
                                       Windows" will be displayed.
                             (vi)      Click on the [OK] button.
                             (vii)     Click on the next [OK] button.
                        8.   Click on the [Start] button of the Task Bar.
                        9.   Click the Restart the computer? option and
                             then click on the [Yes] button.

              Please refer to "Troubleshooting" on page 14 for more
              information4. If you disable your sound card or SPEAKER.DRV
              from Windows, make sure to select the Speaker option from
              the BabyKeys "Preferences" screen.

                             

4 If you experience difficulties in finding or removing your
device drivers, contact Microsoft or its authorized support
center for more assistance.
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INSTALLATION
              To install BabyKeys on your computer, follow these steps5:

              1.   To install BabyKeys from the Windows Program Manager,
                   click on the File menu and select Run. At the file name
                   prompt, type A:\setup.exe (or B:\setup.exe depending on
                   your computer setup). Then click on the [OK] button.

                   To install BabyKeys from Windows95, click on the
                   [Start] button on your Task Bar and select Run. At the
                   file name prompt, type A:\setup.exe (or B:\setup.exe
                   depending on your computer setup). Then click on the
                   [OK] button.

              2.   After a moment the startup screen will appear. You will
                   be prompted with the [OK] and [Cancel] buttons. Click
                   on the [OK] button to continue.

              3.   Next, a dialog will appear with the prompt "Please
                   enter the drive and directory where you wish BabyKeys
                   to be installed". If "C:\babykeys" is not the path that
                   you would like to have BabyKeys installed, you can
                   change it now. Clock on the [OK] button to continue.

              4.   You will be prompted to "Please insert disk 2". Place
                   the disk labelled "2" in the floppy drive. Click on the
                   [OK] button to continue. Respond to the prompts for
                   disk 3 and disk 4, as they appear, in the same manner.

              5.   When the installation process is completed, you will be
                   presented with the "TECHNICAL SUPPORT" screen. Click on
                   the [OK] button to continue.

              6.   The final screen you will see is the "Readme.txt" file
                   displayed in the Notepad program. Please read the

                             

5 NOTE: Throughout this manual, menu titles, options and
messages from the computer will be "QUOTED". Any
dialog button, key press or response that the user
is expected to provide, will be BOLDED or
enclosed in [Braces]. Also, any references to
"click" or "clicking" refers to pressing the left
button on your mouse.
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                   instructions in this file before you continue.

              Once completed, the installation program will create all
              necessary icons and program groups for you6.

GETTING TECHNICAL SUPPORT
              If you are experiencing problems with BabyKeys, first try
              using this manual and the on-line Help facility (see "How to
              use the Help Feature" on page 9). If you are still unable to
              resolve your problem, you can try contacting Multi-Computing
              in one of the following ways:

Telephone: 908-241-8071 (REGISTERED USERS ONLY).
SORRY, NO CALLS RETURNED OUTSIDE
THE CONTINENTAL US!7

Email: CompuServe 74446,1627
Internet 74446.1627@compuserve.com

Regular Mail: Multi-Computing
1051 Stuyvesant Avenue
Suite 347
Union, NJ  07083

              You can also contact us via our web page at
              http://ourworld.compuserve.com/homepages/Multi_Computing.

              When contacting us, please provide the following
              information:

                   1.   The brand and model of your computer.

                             

6 In the case of Windows95, a short cut for BabyKeys will be
added to the "Programs" list of the Task Bar.

7 Telephone support is available only to registered users.
Users contemplating registration can either write us or
email us for technical assistance.
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                   2.   The amount of memory (RAM) available on your
                        computer8.
                   3.   The amount of free space on your hard disk.
                   4.   The version of DOS, Windows or other operating
                        system that you are using.
                   5.   A brief description of the problem including any
                        error messages.

                             

8 Users of MS-DOS 6.X and Windows 3.1 can use the MSD utility
to gather this information.
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USING BABYKEYS

STARTING BABYKEYS
         To get your child started with BabyKeys:

Windows 3.1 users: Double click on the BabyKeys icon found
in the "BabyKeys" program group.

Windows95 users: Click on the [Start] button on the Task
Bar and select Programs. Move to
BabyKeys and click on the BabyKeys icon.

         After BabyKeys has started, let your child sit comfortably in
         front of the computer. Your child can then use the keyboard or
         mouse to control the program. You may want to demonstrate the use
         of this program to your child before they get started. Although,
         there is a very good chance that your child will know what to do
         with the keyboard right away!

SETTING UP PREFERENCES
         When BabyKeys starts for the first time, the program checks to
         see what sound devices are available on your computer. If it
         detects a Sound Card, it will use it as the default sound device.
         Otherwise, the Speaker is selected as the default sound device.
         If you would like to override the default settings, you can
         choose either [Speaker] or [Sound Card] as your preferred sound
         device. To do this, choose Preferences from the File menu. After
         making your selection, remember to save it by clicking the [OK]
         button.

QUITTING BABYKEYS
              Under Windows 3.1 and Windows95, you have a number of ways
              to quit BabyKeys. The most obvious way is to select Exit
              from the File menu. If you are using Windows 3.1, you can
              also click on the [-] button (found in the upper left-hand
              corner of the screen) and then select Close. From Windows95,
              you can click on the [X] button (found in the upper right-
              hand corner of the screen).

              When you attempt to quit BabyKeys, you will get the message
              "Do you really want to quit BabyKeys?". Click on the [Yes]
              button to confirm your choice.
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BABYKEYS' FEATURES
              BabyKeys is a Windows based children's game that works with
              both Windows 3.1 and Windows95. It is loaded with features
              to keep your child entertained. Here are some of these
              features:

o BabyKeys comes loaded with a library of Bitmap and
Windows Meta Files. These files display cartoon
and photographic images that are fun to view.

o It is also loaded with a library of multimedia WAV
files. These WAV files provide BabyKeys with
speech, special effects and musical entertainment.

o Full stereo music and speech are supported.9

o BabyKeys can work with either a sound card or the
PC Speaker.

o It will respond to all keys on your keyboard.
o Responds to the left, right and center mouse

buttons as well as mouse movements.
o The registered version of BabyKeys also works with

a joystick.

HOW TO GET THE MOST FROM BABYKEYS
              For both you and your child to gain the most from "Baby
              Keys" please consider the following suggestions:

                   1)   Always be present when your child is playing this
                        game. You would not want to return to your
                        computer and find grape juice spilled all over
                        your keyboard!

                   2)   Make sure your child sits at least 18 inches away
                        from the computer screen. Also make sure that the
                        keyboard is comfortably within your child's reach.

                   3)   If your child is beginning to talk, you may want
                        to repeat out loud the names of images that appear
                        on the screen. Later, when that image appears
                        again, ask your child to guess the name of the
                        image. However, do not discourage them if they
                        forget the image's name.

                             

9 Stereo sound requires a sound card and external speakers.
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                   4)   Try to avoid letting your child play with this
                        game for more than 10 minutes at a time. As
                        everybody knows, a child's attention span is
                        limited. Observe your child when they play with
                        BabyKeys. If they appear to be losing interest
                        during a play session, move on to something else.

                   5)   Try to have a variety of other computer games
                        available for your child. This way your child is
                        not limited to playing the same game all the time.

              Introducing your child to computers at an early age, will
              help to make them comfortable with new technology as it
              emerges. It will also give them a learning advantage when
              they start school.

HOW TO USE THE HELP FEATURE
              The help system in BabyKeys is context sensitive. This means
              that when you request help, you will be provided with help
              that matches the current screen or operation. However,
              BabyKeys was designed to react to how your child uses the
              keyboard. As a result, the [F1] key has been disabled on the
              main screen10. The main screen is the screen that displays
              the bitmap pictures. To get Help from the main screen, just
              click on the Help menu option then select Contents.

BENEFITS OF REGISTRATION
              You are free to evaluate BabyKeys for up to 14 days from the
              date of first use. After this time, if you continue to use
              BabyKeys, you are expected to register and pay for it. When
              you register your copy of BabyKeys, you will receive the
              Deluxe version of this product. Your registration provides
              the following features and benefits:

o Twice as many multi-media WAV sounds and pictures
in the Deluxe version.

o The Deluxe version is also equipped to work with a
joystick.

                             

10 The [F1] key still works on the "Preferences" and "About"
screens.
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o No shareware registration messages or reminders.
o First time registrants of Multi-Computing products

will be eligible for a $2.00 discount. This
discount can be used towards additional product
purchases or upgrades of any Multi-Computing
product.

o Registered users can receive free telephone based
technical support for up to 90 days from the first
call.

o Registered users will also receive notification of
product upgrades and new product releases.

              If you choose not to register BabyKeys after the evaluation
              period, you should remove it from your computer (see the
              "Uninstall" icon for removing BabyKeys).
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REGISTRATION FORM BabyKeys for Windows (Version 1.0.1)

Name: _______________________________________________________

Address: _______________________________________________________

_______________________________________________________

City: ___________________ State: ___ Zip: _________________

Tel.#: (_____)  _____-__________

SHIP TO...
Name: _______________________________________________________

Address: _______________________________________________________

_______________________________________________________

City: ___________________ State: ___ Zip: _________________

Diskette Size
(Please Circle One): 3 1/2 inch high density (1.44 MB)

3 1/2 inch double density (720 K)

Qty: _____ at $19.95 each Sub Total: _______________

NJ Residents add 6% Sales Tax: _______________

Note: Shipping Cost:
US=$FREE, Can & Mex=$3, Other Int=$7 _______________

Total: _______________

Make check payable in US currency to:   Multi-Computing
1051 Stuyvesant Ave.
Suite 347
Union, NJ  07083

         Please allow 4 to 6 weeks for delivery. Sorry, no COD orders.
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APPENDIX A - GLOSSARY

         The following list attempts to explain some buzz words used in
         this manual:

ARCHIVAL Having to do with an archive (see below).

ARCHIVE In the computer world, this word has to do with
storing or backing up computer data to some form
of backup media (e.g., a floppy diskette).

DECOMPILE The process of converting computer instructions
from machine language to a human readable form
(source code).

DISASSEMBLE The process of converting computer instructions
from machine language to a symbolic code called
assembly language.

ICON In the Microsoft Windows environment an icon is a
small rectangular picture image that usually
represents a computer program.

JOYSTICK A computer input tool similar to a mouse pointing
device. Joysticks are used primarily in video
games.

KEYSTROKE A keystroke represents the pressing of a key or a
combination of keys on the computer keyboard.

MAXIMIZE This is a way to expand a screen so that it fully
occupies the width and height of your computer
monitor (See MINIMIZE below).

MINIMIZE This operation reduces the active window or
program to a small icon. While minimized, the
application is either placed in suspension or runs
in the background.

MOUSE A pointing device that allows you to interact with
your computer in a manner similar to your
keyboard. A mouse usually consists of a palm size
device with a rolling ball at the bottom. It will
normally have two or more buttons for making menu
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selections and changing object properties.

OBJECT CODEThe computer readable instructions produced by a
compiler or special assembler.

SOFTWARE A collection of computer instructions that direct
the computer in performing a specific task. The
Paintbrush program found in Microsoft Windows, is
an example of software.

SOUND
DEVICE A computer component used for generating sound.

This can be either the computer speaker or a sound
card combined with external speakers. The latter
is capable of producing a wider variety of sounds.

SPEAKER An internal sound device found in most IBM
compatible personal computers.

SVGA Super Video Graphics Array. This is a computer
display card that allows the computer to display
images in color. It is usually found in newer
computers.

VGA Video Graphics Array. This is a computer display
card similar to the SVGA card above.
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APPENDIX B - TROUBLESHOOTING

"53:File not found:..." Message
PROBLEM: You are most likely missing a BMP, WAV or WMF

file.
SOLUTION: Re-install BabyKeys.

Bitmap images are Blurred
PROBLEM: The images displayed by BabyKeys are blurred or

hard to recognize.
SOLUTION: The most likely cause of this is a VGA or SVGA

card set to a 16-color display mode. This may also
occur if your video card or video mode is set to a
resolution too low to correctly display these
images. If you are using a video card that
supports multiple modes, you may want to change to
a higher resolution mode. You can do this by
selecting "Windows Setup" (Windows 3.1) or
"Control Panel" (Windows95). Also, if your current
video mode in Windows is set to display only 16
colors at a time, you may want to change this to
at least 256 colors. If none of these suggestions
help, your video card or monitor may be incapable
of displaying at a resolution high enough for
BabyKeys11.

Cannot hear Speech or Music
PROBLEM: You don't hear any of the BabyKeys special

effects, speech or musical melodies.
SOLUTION: This can happen for any of the following reasons:

1. You don't have a sound card or external
speakers installed in your computer. If
this is the case, choose "Preferences"
from the BabyKeys menu and select the
"Speaker" option.

2. Your external speakers may be

                             

11 Although a VGA card with a 640 x 480 resolution is supported
by BabyKeys, it is recommended that you use at least a SVGA
card.
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disconnected or turned off. Please check
your connection and make sure your
speakers are turned on.

3. You are using the SPEAKER.DRV device
driver. Please see the "Compatibility"
section on page 2 for more information.

4. Your sound card may not be capable of
playing WAV files12.

Please see "Speaker not working" and "Sound Card
not working" below for additional tips.

"File not found:..." Message
PROBLEM: BabyKeys is missing a DLL, OCX or VBX file.
SOLUTION: Re-install BabyKeys.

"illegal operation" Message
PROBLEM: A program operation caused Windows to generate a

General Protection Fault error.
SOLUTION: This usually happens if the file "Babykeys.ini" is

missing. Simply start BabyKeys again. If this
problem persists, contact Multi-Computing for
assistance.

"illegal instruction" Message
See "illegal operation" above.

"Insufficient memory or resources..." Message
PROBLEM: Windows did not have enough memory to run

BabyKeys.
SOLUTION: You may have too many applications open at once.

This error may also occur if you have less than
the minimum amount of required memory (refer to
"System Requirements" on page 1). First try
closing other open applications then restart
BabyKeys. If this does not resolve the problem,
you may need to add more memory to your computer.

                             

12 Owners of AdLib sound cards may need to get a special WAV
driver from their vendor or manufacturer.
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"invalid instruction" Message
See "illegal operation" above.

Menu appears when your child uses the keyboard
PROBLEM: The "File" or "Help" menu appears when your child

is using BabyKeys.
SOLUTION: This is not really an error. Under Windows, menus

are invoked when you press the [Alt] key followed
by the short cut key for the menu options listed.
So for example, if you pressed the [Alt] key
followed by the letter "f", the "File" menu will
appear".

To get out of the menu, press the [Esc] key twice
to return to the regular BabyKeys screen.

PC Speaker not working
PROBLEM: No sound is generated when BabyKeys is in use.
SOLUTION: There are several possible cause for this

condition:

1. BabyKeys might be configured for use
with a sound card. You can determine
this by looking at the selections made
in the "Preferences" screen. If "Sound
Card" is selected, change the selection
to "Speaker".

2. Your speaker is currently configured to
work with the Microsoft SPEAKER.DRV
driver. This driver does not always work
reliably with BabyKeys. To remove this
driver from Windows or Windows95, see
"Compatibility" on page 2.

3. Your computer does not have a speaker or
your speaker might be defective. If you
suspect the latter possibility, see your
computer dealer or authorized service
center for assistance.

"Out of memory" Message
See "Insufficient memory or resources..." above.
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Sound Card not working
PROBLEM: Your computer has a sound card, but you do not

hear anything when BabyKeys is run.
SOLUTION: There are several reasons why this might happen:

1. Your external speakers might be turned off.
2. The cable from your sound card to your

external speakers might be disconnected.
3. You might have a driver that conflicts with

your sound card. If you suspect this
possibility, see your computer dealer or
authorized service center for assistance.

4. Your sound card has not been configured or is
missing a device driver. If this is the case
and you need technical help, contact your
sound card vendor. If you are using
Windows95, you can use the "Add New Hardware"
expert found in the "Control Panel" to setup
the correct driver for your hardware.

5. Your sound card is either defective or isn't
capable of playing WAV files. If this is the
case, contact your sound card vendor for
assistance.
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